
Photo Background Removal Services: The Top Five Providers Compared 
When it comes to real estate photography, one of the most important aspects is the background. 
The right background can make or break a photo, and can be the difference between a potential 
buyer taking a second look or moving on to the next listing. 
 
There are a number of different background removal services available, but not all are created 
equal. To help you choose the right one for your needs, we’ve put together a list of the top five 
background removal services and compared them side-by-side. 
 
photo background removal service in India is an essential service for businesses, online sellers, 
and photographers who want to showcase their products or services professionally. With 
affordable prices, quick turnaround time, and excellent quality of work, Indian companies are the 
perfect choice for small businesses looking to outsource their photo editing requirements. 
 
1. Remove.bg 
 
Remove.bg is a fairly new service, but it’s already making waves in the world of real estate 
photography. The service uses artificial intelligence to automatically remove backgrounds from 
photos, and the results are impressive. 
 
Remove.bg is quick, easy to use, and best of all, it’s free. The only downside is that it currently 
only supports JPEG and PNG files, so you’ll need to convert your RAW files before you can use 
the service. 
 
2. Clipping Path India 
 
Clipping Path India is a popular choice for real estate photographers, and for good reason. The 
service offers high-quality background removal at a very reasonable price, and they have a 
quick turnaround time. 
 
Clipping Path India also offers a number of other image editing services, so you can get all of 
your real estate photos edited in one place. 
 
3. Photolemur 
 
Photolemur is another AI-powered background removal service, and like Remove.bg, it’s both 
quick and easy to use. The results are good, but not quite as good as Remove.bg. 
 
One advantage of Photolemur is that it supports RAW files, so you won’t need to convert your 
files before you upload them. The service is also available as a plugin for Adobe Lightroom, 
which makes it even easier to use. 
 
4. Fotor 
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Fotor is a popular online photo editor that offers a number of different tools, including a 
background remover. The tool is easy to use and the results are good, although it can be a bit 
slow. 
 
2. Product Background Removal Services: Which One is Right for You? 
If you're a real estate photographer, then you know that one of the most important aspects of 
your photos is the background. The right background can make or break a photo, and it's 
important to choose the right service to remove it. But with so many options out there, how do 
you know which one is right for you? 
 
In this blog post, we'll compare two of the most popular background removal services: Clipping 
Path India and Remove Background. We'll discuss the pros and cons of each service, so you 
can make an informed decision about which one is right for your needs. 
 
Clipping Path India is a popular background removal service that offers a wide range of features 
and options. They have a wide range of tools that you can use to remove backgrounds, and 
they offer both automated and manual options. You can also choose to have your photos edited 
in Photoshop or Lightroom, or you can use their online editor. 
 
Remove Background is another popular background removal service. They offer a wide range of 
tools and options, and they also offer both automated and manual options. However, they don't 
offer any editing options in Photoshop or Lightroom. Their online editor is also very basic, and it 
doesn't have as many features as Clipping Path India's online editor. 
 
So, which service is right for you? If you're looking for a wide range of features and options, then 
Clipping Path India is a great choice. However, if you're looking for a more basic service that 
doesn't offer any editing options, then Remove Background is a good choice. 
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3. Transparent Background: How to Make Your Images Stand Out 
If you're anything like me, you're probably always on the lookout for ways to make your photos 
stand out. And one of the easiest ways to do that is to remove the background from your 
images. 
 
There are a lot of different ways to do this, but one of the simplest is to use a transparent 
background. This allows you to focus on the subject of your photo without the distraction of a 
busy background. 
 
Here are three tips for making your images stand out with a transparent background: 
 
1. Use a high-quality image 
 
This should go without saying, but it's worth repeating: the quality of your image will have a big 
impact on the final result. If you're using a low-quality image, the background removal process 
will be more difficult and the final result will be less than ideal. 
Clipping path service for furniture images  
Best photo retouching service for wedding photos  
High-end photo retouching service for fashion brands  
Clipping path service for ghost mannequin effect  
Online photo retouching service for Amazon sellers  
Clipping path service for complex images  
 
 
2. Choose the right background removal tool 
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There are a lot of different background removal tools available, and it's important to choose the 
right one for your needs. If you're not sure which tool to use, I recommend checking out this list 
of the best background removal tools. 
 
3. Take your time 
 
Removing the background from an image can be a time-consuming process, so it's important to 
be patient and take your time. If you rush the process, you're likely to end up with an inferior 
result. 
 
4. How to Remove Background in Photoshop: The Ultimate Guide 
Are you a real estate photographer looking to remove the background from your photos? If so, 
you've come to the right place. In this article, we'll show you how to remove the background 
from your photos using Photoshop. 
 
First, open the image you want to edit in Photoshop. Then, go to the "Select" menu and click 
"Select Subject". This will automatically select the subject of your photo. 
 
If the subject of your photo is not selected correctly, you can manually select it by clicking on the 
"Select" menu and then clicking "Select and Mask". 
 
Once the subject of your photo is selected, go to the "Edit" menu and click "Background Eraser 
Tool". 
 
Click and drag the Background Eraser Tool around the subject of your photo to remove the 
background. 
 
When you're finished, go to the "File" menu and click "Save". 
 
5. Photo Background Editor: The Best Software for the Job 
Are you a real estate photographer looking for a good photo background editor? If so, you've 
come to the right place. In this blog post, we'll be discussing the five best photo background 
editors available on the market today. 
 
1. Adobe Photoshop 
 
Adobe Photoshop is widely considered to be the best photo editing software on the market. It 
offers a wide range of features and tools that allow you to easily remove backgrounds from 
photos. 
 
2. GIMP 
 



GIMP is a free and open-source photo background editor that offers a wide range of features 
and tools. It's a great alternative to Photoshop if you're looking for a free option. 
 
3. Paint.NET 
 
Paint.NET is a free and easy-to-use photo background editor. It offers a wide range of features 
and is a great alternative to Photoshop if you're looking for a free option. 
 
4. PhotoScape 
 
PhotoScape is a free and easy-to-use photo background editor. It offers a wide range of 
features and is a great alternative to Photoshop if you're looking for a free option. 
 
5. Fotor 
 
Fotor is a free and easy-to-use photo background editor. It offers a wide range of features and is 
a great alternative to Photoshop if you're looking for a free option. 
 
6. Remove Background from Image: Tips and Tricks 
Are you a real estate photographer looking to improve your photo editing skills? In this blog 
post, we'll share six tips and tricks for removing backgrounds from images. With these tips, you'll 
be able to create clean, professional-looking photos that will help your listings stand out from the 
competition. 
 
1. Use a tripod 
 
When removing backgrounds from photos, it's important to have a stable camera. Using a tripod 
will help you avoid camera shake, which can create blurry or distorted images. 
 
2. Use a wide aperture 
 
Using a wide aperture will help you achieve a shallow depth of field. This will make it easier to 
blur the background of your photos and make the subject stand out. 
 
3. Use a long focal length 
 
Using a long focal length will also help you achieve a shallow depth of field. This will make the 
background appear more blurred and help the subject stand out. 
 
4. Use a high ISO 
 
Using a high ISO will help you avoid camera shake and produce sharper images. However, be 
careful not to use an ISO that is too high, as this can create noise in your photos. 
 



5. Use a fast shutter speed 
 
Using a fast shutter speed will help you freeze any movement in your photos. This is especially 
important when removing backgrounds from photos of people or animals, as any movement can 
create blurriness. 
 
6. Use editing software 
 
There are many different editing software programs available, both paid and free. Using editing 
software can help you fine-tune your photos and perfect your background removal skills. 
 
7. Photoshop Background: How to Create Professional-Looking Images 
Are you looking to create professional looking images in Photoshop? If so, then you'll want to 
check out these seven background removal techniques! 
 
1. Use the Pen Tool 
 
The pen tool is one of the most powerful tools in Photoshop. It allows you to create precise 
selections, which is essential for background removal. 
 
To use the pen tool, simply click and drag around the edges of the object you want to selection. 
As you do this, you'll create anchor points. You can then adjust the position of these anchor 
points to fine-tune your selection. 
 
2. Use the Quick Selection Tool 
 
The quick selection tool is a great option if you're not comfortable with the pen tool. It's also a 
good choice for quickly removing simple backgrounds. 
 
To use the quick selection tool, simply click and drag over the area you want to select. The tool 
will automatically create a selection around the edges of the object. 
 
3. Use the Magic Wand Tool 
 
The magic wand tool is another great option for quickly removing simple backgrounds. It's 
especially handy for removing solid color backgrounds. 
 
To use the magic wand tool, simply click on the area you want to select. The tool will 
automatically create a selection around the edges of the object. 
 
4. Use the Background Eraser Tool 
 
The background eraser tool is a great choice for removing complex backgrounds. It allows you 
to selectively erase parts of the background, without affecting the foreground. 



 
To use the background eraser tool, simply click and drag over the area you want to erase. The 
tool will automatically erase the background pixels that it comes in contact with. 
 
5. Use the Clone Stamp Tool 
 
The clone stamp tool is a great choice for removing complex backgrounds. It allows you to clone 
pixels from one area of the image and apply them to another area. 
 
To use the clone stamp tool, simply select an area of the image that you want to clone. Then, 
click and drag over the area you want to apply the clone. The tool will automatically clone the 
pixels and apply them to the new area. 
 
6. Use the Content-Aware Fill 
 
The 
 
8. Background Editor: The Best Tools 
The Background Editor is one of the best tools that you can use to improve your real estate 
photos. This tool can help you remove unwanted objects from your photos, as well as change 
the background to something more pleasing. Here are eight of the best background editors that 
you can use to improve your real estate photos. 
 
1. Adobe Photoshop 
 
Adobe Photoshop is a widely used program that can be used to edit photos of all types, 
including real estate photos. Photoshop has a wide range of features that can be used to 
improve your photos, including the ability to remove objects and change backgrounds. 
 
2. GIMP 
 
GIMP is a free program that can be used to edit photos. It has many of the same features as 
Photoshop, including the ability to remove objects and change backgrounds. 
 
3. PicMonkey 
 
PicMonkey is a web-based program that can be used to edit photos. It has a wide range of 
features, including the ability to remove objects and change backgrounds. 
 
4. Fotor 
 
Fotor is a web-based program that can be used to edit photos. It has a wide range of features, 
including the ability to remove objects and change backgrounds. 
 



5. BeFunky 
 
BeFunky is a web-based program that can be used to edit photos. It has a wide range of 
features, including the ability to remove objects and change backgrounds. 
 
6. PhotoFiltre 
 
PhotoFiltre is a free program that can be used to edit photos. It has many of the same features 
as Photoshop, including the ability to remove objects and change backgrounds. 
 
7. Paint.NET 
 
Paint.NET is a free program that can be used to edit photos. It has many of the same features 
as Photoshop, including the ability to remove objects and change backgrounds. 
 
8. IrfanView 
 
IrfanView is a free program that can be used to view and edit photos. It has a wide range of 
features, including the ability to remove objects and change backgrounds. 
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